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Ausbildung 
Was macht eine  
gute VFX-Uni aus? 

Tests     
Eizo, Philips, Soundweaver, 
Woosh und Akeytsu 

und vieles mehr  
Flame, Blender, InstaLOD, 
Nuke 12.1, Topaz und mehr
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Projekte     
Mulm, The Witcher, Marvel 
Heros, Walking Dead: Maya 



Der Schnitt ist in vollem Gange, 
jetzt geht es ran an den Feinschliff. 
Die Tonbearbeitung steht beson-
ders im Fokus. Dabei gibt es viele 
Einstellungen und Kniffe, die das 
Keyboard zum Rauchen bringen.
 von Florian Eisner

Audio in Avid

Egal ob nun O-Töne, Atmos, Foleys oder 
Temp-Tracks für den Schnitt benötigt 
werden, hierfür bieten sich zwei Mög-

lichkeit des Ladens an. Dafür steht einem 
einerseits die klassische Importfunktion zur 
Verfügung, aber auch der Befehl-Link. Bei-
des findet man gesammelt im Fenster des 
Source-Browsers vor. Dieser ist über die 
Menüleiste sowohl direkt unter Tools zu fin-
den als auch über File > Input. Neben dem 
Source-Browser stößt der User hier ebenso 
auf den Befehl „Import Media“, falls man 
über den herkömmlichen Weg ausschließlich 
importieren möchte, was gerade bei Audio 
mittlerweile im Media Composer sehr rasch 
geht. Das Linking geht zwar noch schneller, 
wobei dann ein anschließender Consolidate 
immer noch anzuraten ist. 

Doch bevor es zum Einspielen kommt, 
stellt sich die Frage: Wie nun mit dem Material 
umgehen? Dafür gibt es schließlich separate 
Settings. Diese sind im Source-Browser in 
der unteren Hälfte des Fensters anzutreffen. 
Unter den Source-Browser-Settings zeigt 
sich, was ein Doppelklick der Files bewir-
ken soll, ob diese nur im Composer-Fenster 

geladen oder gleich verlinkt werden sollen 
und ob geöffnete Dateien im Composer nach 
Schließen des Browsers auch zu schließen 
sind oder ob nach Link- / Importvorgängen 
der Source-Browser zu schließen ist. 

Aber zusätzlich lassen sich im Browser un-
ter einem sternartigen Symbol weitere Jus-
tierungen vornehmen. Für die Funktion Link 
sind hier Qualitätseinstellungen aufgelistet, 
mit denen sich zwischen Highest Quality und 
Most Compressed wählen lässt. Unter Volume  
Mounting verbirgt sich u.a. der Befehl Auto-
matically link to Volumes, was einem ein 
automatisches Linken bei angeschlossenen 
Speichermedien ermöglicht. Dieses kann 
aber hier wieder deaktiviert werden. Bei den 
Link Options wird es dann für das Audio im 
Speziellen wieder interessant.

Multipass, äh, Channel! 

Dort wird einem die Funktion Multichannel 
Audio (Mono, Stereo, 5.1, 7.1) angeboten, wo 
sich der Umgang mit Audioclips, die meh-
rere Spuren enthalten, handhaben und de-
finieren lässt. Außerdem ist die Einstellung  

Audio Timecode Rate recht praktisch. An 
dieser Stelle kann man sich durch den Be-
fehl Ask for Rate bei der Verwendung von 
Ausgangsmaterial mit anderen Frameraten 
als die des aktuellen Projekts warnen lassen. 
Beim Wechseln im Source Browser von Link 
auf Import gibt es für das Importieren noch 
einige weitere interessante Settings. Diese 
sind wieder unter dem erwähnten Settings-
Symbol zu finden. Hier lässt sich die Sample-
Rate des Tonmaterials gleich beim Import zur 
Projekt-Sample-Rate konvertieren. Auch die 
Bittiefe kann man abwandeln. 

Mit einem weiteren Haken lassen sich 
sogar Monoclips gleich automatisch mittig 
ausrichten. Nebenbei erwähnt, sind viele 
solcher Projekteinstellungen wie Sample-
Rate und Bittiefe im Setting Audio Project 
anzufassen. Dies findet man in der Menü-
leiste unter File > Settings. Vorsicht ist nun 
beim eigentlichen Einladen geboten, falls 
man sich für den herkömmlichen Weg des 
Importierens entscheidet. Daher kann ein 
Blick in die allseits relevante Media Creation 
nicht schaden, ob für den jetzigen Vorgang 
die richtige Festplatte ausgewählt wurde. 

Obwohl dies auch im Source-
Browser (bei Import) wie im 
Import-Media-Fenster einstell-
bar ist, empfiehlt sich der Kon-
trollcheck in der Media Creation 
immer. Insbesondere weil dort 
generell Übersicht behalten wer-
den sollte, wie man seine Medien 
behandelt. Darüber hinaus finden 
sich hier weitere relevante Ein-
stellungen, die von Bedeutung 
sind, wie das Audio-Wrapper-
Format (PCM: Avid OP-Atom, 
WAVE: OMF, AIFF-C: OMF). Nun 
kann dem Laden nichts mehr im 
Weg stehen.

Audio im Projekt

Ein konsequenter Workflow ist 
immer nett – das Audio-Footage 
ist idealerweise wie alles andere 
in klar beschrifteten Foldern und 
Bins zu sammeln. Durch den gro-
ßen Media Composer Relaunch in 
2019 (DP berichtete in der Ausga-
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be 06:19) kann dies bequem in der Sidebar 
eines Bin Containers erstellt und organisiert 
werden. 

Nebenan angedockt öffnen sich die Bins, 
die auf verschiedene Weise verschiebbar 
und anderweitig andockbar sind. Dies gut 
im Griff zu haben, erleichtert einem einiges, 
gerade wenn die große Sucherei beginnt, wo 
denn dieser und jener Ton aus dem Roh-
material wäre. Daher ist es ein Segen, wenn 
der Tonmeister hierfür bereits beim Dreh für 
die Postproduktion mitdenkt. Eine angeneh-
me Lösung für solche Suchaktionen im Bin 
Container stellt hier das sogenannte Filter 
Field dar. Es handelt sich hierbei um eine 
Suchmaske, in die man Dateinamen einge-
ben und nach diesen filtern kann. 

Wer sich lieber durch 
die Bins bewegen will, 
dem ist die Bin Map ans 
Herz zu legen. Mit die-
ser Minivorschau eines 
Bins ist es möglich, sich 
gerade bei einem sehr 
massiven Bin sehr gut 
durch das Footage zu 
bewegen. Des Weite-
ren kann es hilfreich 
sein, sich die wichtigs-
ten Spalten in den Bins 
zurechtzulegen, gerade 
wenn es darum geht, 
einzelne Informationen 
zu erhalten. Dies lässt 
sich über das Bin-Fast-
Menü machen – Choose  
Columns. Hier erhält 
man umfangreiche 
Spalten, die einem 
wichtige Auskünf te 
über das Footage auf-
zeigen wie z.B. Audio 
SR, Audio Bit Depth 

oder Audio File For-
mat. Mittlerweile gibt 
es auch noch das 
Inspector Tool, das 
sich überall bequem 
im neuen Panel-UI-
Gewand andocken 
lässt. Hier werden 
dem User viele Me-
tadaten auf einen 

Blick serviert. So ist noch übersichtlicher, 
was für Infos das aktuell im Composer-
Fenster vorliegende Material beinhaltet. 
Nun steht einer ausführlichen Sichtung 
oder, wie man in diesem Fall besser sa-
gen sollte: Hörung nichts mehr im Wege. 
Wer sich für das Sichten in Avid näher in-
teressiert, kann dort einmal einen Blick  
hineinwerfen: bit.ly/trick_for_click_10.

Tools andocken

Zuallererst soll gesagt sein, dass neben den 
üblichen Workspaces (Edit, Color, Effects, 
Audio) auch neue Arbeitsbereiche nach 
eigenen Vorstellungen erstellbar sind und 
diese dementsprechend benannt werden 
können. Somit auch weitere Workspaces für 
andere Anwendungsbereiche. Doch warum 
alles schwieriger machen, als es ist? 

So liegt es nahe, die vorhandenen Work-
spaces zu übernehmen und nach Notwen-
digkeit mit Fenstern sowie Tools auszustat-
ten, die einem belieben. Im hiesigen Fall also 
für Audio. Die unbedingten Must-have-Tools 
wären hierfür das Audio Tool sowie der Au-
dio Mixer. Das Audio Tool ist sehr wichtig, um 
den Pegel des Rohmaterials oder der Time-

line zu überwachen. Daher sollte man dort 
gleich zu Anfang eines Projekts per Links-
klick über den PH-Button durch die Anwei-
sung Set Reference Level das Grenzniveau 
des Pegels einrichten. 

Obendrein bietet der PH-Button durch 
die Auswahl der Input und Output Settings 
den Zugang zu den Audio Project Settings. 
In diesen Registerkarten lassen sich u.a. die 
Input Source sowie die Output-Ausgabe der 
Software zu Stereo, Mono, 5.1, 7.1 oder Di-
rect Out anwählen. Besonders wenn viele 
Beteiligte auf einem Projekt sitzen, kommt 
es zu einigen Fehlerquellen. Bei Audio sind 
diese oftmals hier zu suchen, falls man 
klanglich nur einen Teil der Mischung oder 
gar nichts hört. Insgesamt ist das Audio Tool 
daher ein gutes Prüftool, was äußerst wich-
tig wird, falls kein externes Audiomessgerät 
am Schnittplatz vorhanden ist. Das Herz-
stück der Tonwerkzeuge bleibt aber der Au-
dio Mixer. Mit diesem wird am meisten ge-
arbeitet. Dort sind sämtliche Tonspuren der 
Timeline wie auch des Rohmaterials als ein 
digitales Mischpult auffindbar. Oberhalb des 
Fensters finden sich wiederkehrende Tools 
und Funktionen vor. Mit ihnen kann man die 
Output Settings praktisch erneut umstellen, 
den Audio Loop Play benutzen oder durch 
Render Effect gegenwärtig in der Timeline 
liegende Effekte rendern. 

Am untersten Ende des Fensters findet 
sich schließlich die schriftliche Auflistung der 
Tonspuren mitsamt des jeweiligen Eingabe-
feldes vor, welches den bearbeiteten Pegel-
wert der Spur darstellt. Um also diesen nicht 
immer mit dem Fader anfassen zu müssen, 
ergibt sich im Eingabefeld auch noch durch 

109

TRICK FOR CLICK | EPISODE 7



Klick und händisches Tippen die Möglichkeit, 
diesen ebenso zu verändern. Des Öfteren 
steht man vor der Anforderung, mehrere 
Clips gleichzeitig derselben neuen Pegelma-
nipulation zu unterziehen. 

Dafür kommt die sogenannte Group zum 
Einsatz. Zu finden ist diese Funktion ober-
halb des Tools, sie ist durch eigene Module 
der Audiospuren abgebildet. Durch Ankli-
cken aktiviert man diese, und eine anschlie-
ßend einmalig vollzogene Eingabe des Pe-
gelwertes reicht aus, um den Pegel mehrerer 
Spuren gleichermaßen abzuändern. 

Unter den Group-Modulen befindet sich 
die Funktionalität, dargestellt durch Regler 
und Display, welcher physische Lautsprecher 
angesprochen werden soll. Um dies umzu-
stellen, kann man am Regler durch Klicken 
und Ziehen diesen Wert dementsprechend 
verschieben. Ein Bonus-Tipp wäre hier, dass 
mit gedrückter Alt-Taste ein Mausklick auf 
den Regler ausreicht, um auf mittig abzu-
stimmen. Auch da kann das Grouping Be-
schleunigung bringen. 

Einige weitere sehr zeitsparende Funktio-
nen sind die im Rechtsklick auf die Tonspu-
ren enthaltenen Befehle Set Level, Set Pan 
On Track – In / Out. Damit lassen sich sämt-
liche Audioclips, die in der Timeline markiert 
sind, in einem Rutsch nach Lautstärke abän-
dern – ausgerichtet an dem aktuell am Cur-
sor in der Timeline befindlichen Audioclip. In 
erweiterter Weise finden andere Tools wie 
die Audio Suite oder auch das Punch-In Tool 
ab und an Verwendung. 

Die Audio Suite bietet eine umfangreiche 
Palette von Toneffekten an. Einer der am 
häufigsten genutzten Toneffekte ist der EQ3 
7-Band. Falls ein O-Ton zu leise oder zu 
dumpf anmutet, schafft dieser Effekt durch 
Anpassungen mit Gain, Frequenz und Reso-
nanzschärfe Abhilfe. Das Punch-In bietet die 
Möglichkeit für Sprachaufnahmen. In einem 
einfach gehaltenen Fenster findet man dafür 
alles Notwendige auf einen Blick. 

Wie z.B. einen Vor- zuzüglich Nachlauf 
der Aufnahme, welche Input Source und 
welche Festplatte zum Rendern benutzt 
werden soll. Außerdem wählt man die Op-
tionen für den bevorzugten Bin sowie die zu 
verwendenden Audiotracks der in der Time-
line liegenden Sequenz aus.

Ton in der Timeline bearbeiten

Die Behandlung der Töne in der Timeline 
stellt die Quintessenz dar. Letztlich kommen 
nun alle akustischen Medien zusammen. 

Hier landen die Töne die essenziell sind, hier 
schneidet und zerschneidet man, um klar zu 
sein wie obendrein Spannung zu erzeugen. 
Aber die Mischung machts, was wann zur 
Geltung kommen soll. Um dabei den Über-
blick zu behalten, erfordert es neben einem 
handwerklichen Geschick auch kluge Tools. 
Dafür gibt es diverse Optionen.

Doch wenn man sich auf ein paar weni-
ge Handhabungen konzentriert, kommt man 
an der Waveform nicht vorbei. Sie ist eine 
wichtige visuelle Darstellung der akustischen 
Schwingungen, die gerade in der Timeline 
ablaufen. Diese Abbildung kann darin enorm 
unterstützen, was gerade akustisch abläuft 
und wo sich das genau befindet. Über das 
Fast-Menü der Timeline wird die Waveform 
aktiviert: Audio Data > Waveform. Damit 
wird die Waveform sämtlicher Tontracks ab-
gebildet. 

Meistens liegt die Konzentration auf 
einzelnen Spuren nebst Clips. Mitten darin 
wird oftmals zwischen den Spuren hin- und 
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hergewechselt. Da stellt das Track Control 
Panel eine echte Alternative dar. Dieses 
ist oben links in der Timeline rechts neben 
einem kleinen Sequenz-Timecode-Display 
zu finden. Das Panel wird durch einen klei-
nen Pfeil symbolisiert. Nachdem dieser ein-
mal angeklickt wurde, verbreitern sich die 
Tracks. Das eröffnet einem viele weitere 
Möglichkeiten neben dem üblichen Stumm-
schalten plus Isolieren von Tracks. Hier hat 
man nun auch die Gelegenheit, Audioeffek-
te direkt auf eine ganze Spur anzuwenden 
oder gar ganze Spuren zu deaktivieren. 

Aber zusätzlich, dargestellt durch ein 
kleines Waveform-Symbol, kann eben die 
Waveform einzeln pro Spur bequem an- 
und ausgeschaltet werden. Was einem eine 
ungeahnte Freiheit im Gegensatz zur her-
kömmlichen Methode bei der Darstellung 
der Waveform bietet. Positiv zu bewerten 
ist, dass diese sich mittlerweile sehr stabil 
verhält, selbst bei vielen Tonspuren und im 
Einsatz der sogenannten Live-Timeline. Mit 
der Live-Timeline lässt sich nämlich beim 
Abspielen der Timeline auch ein zeitgleiches 
Zoomen durchführen oder gar Arbeit in den 
Bins nebenher bewerkstelligen. 

Ein zweites sehr wichtiges Tool bei der  
Timeline-Arbeit, das man hervorheben 
muss, wäre das Toggle Digital Audio Scrub. 
Früher war dieses Werkzeug voreingestellt 
auf der Feststelltaste abgelegt. Nun befreit 
davon kann dieses Tool überall sonst auf 
dem Keyboard abgelegt werden. 

Das Scrub-Tool verbirgt sich in der Com-
mand-Palette unter dem Reiter Play. So ist 
es bequem von der Tastatur an- und abwähl-
bar. Das bedeutet eine große Arbeitserleich-
terung, da oft Frame-by-Frame durch das 

Material gescrubbt werden muss, um bei-
spielsweise einzelne Silben in On-Situatio-
nen zu verstehen und diese bei Bedarf her-
auszuschneiden oder gar mit anderen Silben 
zu ersetzen. Doch auch beim Musikschnitt 
hat sich das Scrubbing als unverzichtbar he-
rausgestellt. So ist man visuell und akustisch 
gewappnet, wenn es um Feinheiten in der 
Timeline geht.

Überblick

Insgesamt lässt sich sagen, dass sich mittler-
weile in Media Composer ein breites Feld im 
Umgang mit Tonmaterial anbietet. Gerade 
einige Neuerungen und Performance-Ver-
besserungen aus den letzten Jahren haben 

hier für Optimierung gesorgt. Dabei sind vor 
allem die stabilere Waveform-Darstellung 
sowie die neue flexiblere Live-Timeline, die 
sich Avid-User schon lange wünschten, her-
vorzuheben, aber ebenso ein deutlich flüssi-
geres Audio Scrubbing als früher ist feststell-
bar. So macht Tonschnitt Spaß. › ei

Florian Eisner ist ein freischaffender Film-
Editor. In den letzten Jahren hat er ein 
paar Hundert Projekte geschnitten. Er 
wird weltweit gebucht für Spielfilm, Fic-
tion, Commercial und Musikvideo. Ebenso 
ist er Herausgeber des Youtube Channels 
uncompressor tv.  www.florianeisner.com
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